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The Fundamentals

If you attend a lot of meetings where you need to take
notes, OneNote is a helpful program to use. OneNote is
Microsoft’s notetaking software that collects typed or
written notes, drawings, tables, and screen clippings.
OneNote is like a digital notepad but is much more
organized. Instead of having to flip through each note to
find what you’re looking for, OneNote saves notes in
pages which are organized into sections within
notebooks. OneNote is a very collaborative program
and notes can be shared with other OneNote users.

This module is an introduction to working with
OneNote. You'll learn about the main parts of the
program screen, how to give commands, and how to
use help.

Objectives
Understand the Screen
The Quick Access Toolbar
Change Views

Search Notes

Print

Help

© 2019 CustomGuide, Inc.
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U ndersta nd the Scree n Commented [IG1]: Practice File: Q1 Review

Point out to the class the different areas of the OneNote
screen.

((:.) a5 = Q1 Review - OneMote Kayla Claypool

File Home Insert Draw Histary Review e
I|__ := NST Notes » Meetings Media Posts Destinations Expenses + search (Ctrl <) P~

- (+) Add Page

Q1 Review

Friday, September 23, 2016 12:14 PM 07 Review
02 Review

Agenda Q3 Review

Summary of Previous Quarter Q4 Review

‘What's Coming This Quarter
Financials
Take-Away ltems

Notes

Sales this quarter have been down compared to Q4 of last year

Need to identify reasons and solutions

New social media strategies are in the works in the Marketing Department
A push is needed at years end to avoid the problem next year

What can we do?
Research potential destination "hot-spots”
Brainstorm with team 1 new excursion in each of the top 5 destinations

o Title Bar: Displays the name of the current o Help/Display Options: Here you can see
file. the help feature, change how much of the
ribbon is displayed, minimize, maximize or
restore the screen, or close Excel
altogether.

e Quick Access Toolbar: This is a fast way to o Microsoft Account User Info: When you
access the most used features. log in with your Microsoft account, your
name and picture appear here.
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Social Media - OneNote  Kayla Claypool

Home Insert Draw History Review View E

I|::= NST Notes + Meetings Media Posts Destinations Expenses + Search (Ctri=E) P -

a 2 (+) Add Page l
S&®| Media ¢
Friday, September 23,2016 12:14 PM o SodgiMedia

Facebook

Twitter

Social media continues to be a great advertising resource for North Shore Travel. It is important
to keep track of posts on each social media site to avoid duplicate posts in the future. If you
have suggestions for other sites to advertise on, post a note on this page!

o The Ribbon: This is where you'll find all the 0 Notebook Sections: Each subject is
options you need to create, format, and separated by a tab. Click a tab to jump to a
organize your notes. It's collapsed by different section.
default in OneNote, so just click a tab to
expand it and see the options.

Active Notebook: This is where you'll find 0 Notebook Pages: Each page in a section is
the name of the current Notebook. listed at the right. Click a page to view its
content.

Search Field: The search field lets you
search for specific text within a page,
section, notebook, or all open notebooks.

© 2019 CustomGuide, Inc. 11



h’he Quick Access Toolbar\

The Quick Access Toolbar holds a few buttons for commands that you'll use often, such as back and undo.
You'll notice there is no save button like in other programs, and that's because OneNote saves everything
automatically. There's no need to ever save manually!

]Customize the Quick Access Toolbar

0 Click the Customize Quick Q1 Review - OneNote  Kayla Claypol
Access Toolbar button. iusl;mi::Qui(kA((:isToolbar Fezy  Crze
el : TNS|  Forverd fa— e ——— P earch (Ctrl-)
This list displays some common  |.== %] "™ pos | Daseratons ([Eiperees |+ Searc (C1-9

. (@) Add Page
commands you can add. But if ol = - 9

Print

you don't see the one you 4 . O Review
rint Preview Q2 Review
need, you can click More agel  FavoricePen | Q@ Review
. - SUMY Fayorite Pen 2 g eview
Commands and find it in the wd o
dialog box. Tak]  FavoritePen 4
ot Favorite Highlighter 1
ot
e Select a command to add. cale]  Touch/Mouse Mode bared to Q4 of last year
Nee| Meore Commands...
New, ;M Selow the Fibbon Jorks in the Marketing Department
apl . he problem next year

What can we do?
Research potential destination "hot-spots”

e
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{Commented [1G2]: Practice File: Social Media

Commented [IG3]:
1. Click the Customize Quick Access Toolbar button.

2. Select Print.




{Commented [IG4]: Practice File: Notebook

\Change Views\

There are a few different view options you can change in OneNote to make note-taking more efficient.

‘Ribbon Views Commented [IG5]:

o Click the Ribbon Display
Options button.

®© © = Q Review - OneNote  Kayla Claypool (g e =

1.Click the Ribbon Display Options button.

File Home  Insert  Draw  History  Review  View

bon. Click at the top

of the application to showit. 2. Select Show Tabs and Commands.
Show Tabs is the default view. NST Notes ~ [Wiedines " (ieagpese)) Jsinsions) (Epene E o
i . 2b to show the commands.
If you want to hide all of the Q1 Review -
ribbon, you'd choose Auto- Friday, September 23,2015 12:14 M BE= Show Ribbontabs and
commands all the time.
hide Ribbon. Agenda Q3 Review

Summary of Previous Quarter 4 Review
. . What's Coming This Quarter
e Select a display option. Financials

Take-Away Items.

Notes

Sales this quarter have been down compared to Q4 of last year

Need to identify reasons and solutions

New social media strategies are in the works in the Marketing Department
A push is needed at years end to avoid the problem next year

What can we do?
Research potential destination "hot-spots”

© 2019 CustomGuide, Inc. 13



Notebook Views

o Click the Full Page View
button.

Everything else is collapsed to
give you more note-taking
space.

e Click the Normal View button.

Q1 Review - OneNote  Kayla Claypool

Commented [IG6]:
1. Click the Full Page View button.

2. Click the Normal View button.
3. Click the View tab.
4. Click Dock to Desktop.

5. Click the Normal View button.

I insert  Draw  History  Review  View
o . ~ |
0 Calibri -1 -z As 1;@ T"D"ng = rl—‘_l‘]
Pasts 5 sc: T Email  Mect
aste Y s Tag mail | Mesting
T | B f M [F A0S A = |* OutiookTasks~  page  Detaile
Ciipboard BasicText Styles Tags Email | Meetings ~
[} NST Notes + [ Mestings | (iZaipas) (Dtnssons ) (Eaean) - Seareh (Ctri=E) P~
] o | @ hddPage
Q1 Review
Friday, Se mber 23, 2016 12:14 PM AR e
Q2 Review
Agenda Q2 Review
Summary of Previous Quarter @
What's Coming This Quarter
Financials
Take-Away Items
Notes
Sales this quarter have been down compared to Q4 of last year
Need to identify reasons and solutions
New social media strategies are in the works in the Marketing Department
A push is needed at years end to avoid the problem next year
What can we do?
Research potential destination "hot-spots”
X
R NST Notes > Meetings ¥ 2
Ql Review R
12:14pM
=

Agenda

Summary of Previous Quarter
What's Coming This Quarter
Financials

Take-Away Items

Notes

Sales this quarter have been down compared to Q4 of last year

Need to identify reasons and solutions

New social media strategies are in the works in the Marketing Department
Apush s needed at years end to avoid the problem next year

What can we do?
Research potential destination "hot-spots"
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O®

View options can also be found @ - Q1 Review - OneNote  Kayla Claypool

on the VIEW tab. File Home Insert Draw History Review
@ E E)i( IE (_\ (i.)\ Q0% - 1 EllNew Docked Window
i 100% j} N e Not
Click the tab. Normal Full Page Dockto  Page Rule  Hide  Paper Zoows£oom g New XD
View  View Desktop Color~ Lines~ PageTitle Sze ~ Out  In ‘0'PageWidth | \indoy A Aways onTop
. Views Page Setup Zoom Window ~
Click . -
LI} NST NoSg#* | Meetings ' (ictiaPasts™) (Destinations " (JEpenelh + Search (Ctri-E) R
The OneNote window is . dd page
docked to one side of the Q1 Review v
. Friday, S 23,2016 a M e
screen so you can easily work Q2Review
. Agenda Q3 Review
in another program at the Summary of Previous Quarter e
. What's Coming This Quarter
same time. Financials
Take-Away Items
Click the button. Notes
Sales this quarter have been down compared to Q4 of last year
Need to identify reasons and solutions
New social media strategies are in the works in the Marketing Department
A push is needed at years end to avoid the problem next year
What can we do?
Research potential destination "hot-spots™
X
Q1 Review
Friday, ber 23, 2016 12:14PM
Agenda
Summary of Previous Quarter
What's Coming This Quarter
Financials
Take-Away Items.
Notes
Sales this quarter have been down compared
t0 Q4 of last year

Need to identify reasons and solutions
New social media strategies are in the works
in the Marketing Department

A push is needed at years end to avoid the
problem next year

What can we do?
Research potential destination "hot-spots"

-,
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Notebook Pane

o Click the Notebook list arrow.

o Click the Pin Notebook Pane to
Side button.

Now the Notebook pane stays
open on the left so you can
easily see all of your open
notebooks and quickly switch
between them.

o Select a notebook from the
pane.

o Click a notebook's list arrow.

Q1 Review - OneNote  Kay|

jome  Inset  Draw  History  Review

- r’ﬂ 1] New Docked Window

New Quick Note

s B AEEENECE
B 100%
Normal Full Page Dockto  Page Rule  Hide  Paper Zoom Zoom New
View st olor - Lines~ PageTitle  Size  Out  In ‘0 PageWidth  yindow A Aways on Tap

Views Page Setup Zoom

[} NST Notes v [ Mestings | (iZaiaposel), (Desinssons ) (e

. 2]

(@ Add Notebook
My Vacation

NST Notes

Open Other Notebooks
styear

eting Department
year

T uick Netes

What can we do?
Research potential destination "hot-spots”

+

Window

4

Search (Ctri=E)

(%) Add Page

QI Review
Q2 Review
Q3 Review
Q4 Review

Commented [IG7]:
1. Click the Notebook list arrow.

2. Click the Pin Notebook Pane to Side button.
3. Select the My Vacation notebook.
4. Click the NST Notes notebook list arrow.

5. Click the MY Vacation notebook and drag it under the
NST Notes notebook.

6. Click the Unpin Notebook Pane to Side button.

Day 1 - OneNote

Home  Inset  Draw History

EEEREEEE

Kayla Claypoal

*| P ellNew Docked Window
T3 New Quick Note

Window

Search (Ctri+E)

4

(1) Add Page

Day 1
Day 2

[El 100%
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Views Page Setup Zoom

Notebooks ¥ | Destinations 8-Doieme ) Resenvations | +

My o

Vacation

Day 1
NST 2 i
Notes Friday, September 23,2016 12:28PM
ﬁ Tokyo, Japan.
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Day 4
Day5s
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Click a notebook and drag it to
a new location.

Click the Unpin Notebook
Pane to Side button.

Home

Normal Full Page Dockto

few | View

Views

Notebooks *
My
Vacatjpn
NST
Note:
Meetings
Media Hosts
Destinafions
Expens

|E Quick Notes

Q1 Review - OneNote

Kayla Claypool

Insert  Draw  History

1 & B X

Page Rule  Hide
p  Color~ Lines~ Page Title

Review
Paper  Zoom Zoor
See | Out I
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[El 100%

m
“Cr Page Width

) ElNew Docked Window
D New Quick Note

ew
Window A Always on Top

Page Setup Zoom Window
Meetings  MediaPosts ~ Destinations | Expenses |+ Search (Ctri+E)
B () Add Page
Q1 Review
Friday, September 23,2016 12:14 PM Q1 Review
Q2 Review
Agenda Q3 Review
Summary of Previous Quarter Q4 Review

What's Coming This Quarter
Financials
Take-Away Items

Notes

Sales this quarter have been down compared to 4 of last year

Need to identify reasons and solutions

New social medi inthe works in the Marketing Department
A push is needed at years end to avoid the problem next year

What can we do?
Research potential destination "hot-spots”

~

o~
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]Search Notes

Trying to find were you put a specific note can be a daunting task! Luckily, OneNote has some pretty
powerful search capabilities to help you find just what you're looking for.

Click in the Search field and
type something you’re looking
for.

OneNote automatically starts
searching all open notebooks
and shows which notebook
contains a match, as well as
the section.

Click the Search list arrow.

You can then search a specific
location.

Select a search option.
Select a search result.

You jump to the page that
contains the term and it's
highlighted here. OneNote also
finds results in images and
even hand-written notes, if you
write clearly enough.

Click Find on page.

This is helpful when there are
multiple instances of the word
on a single page.

Shortcut: Ctrl + F.

Q1 Review - OneNote

Insert  Diaw  History  Review  View

-

0 Calibri - K e)l
Pt ¢ B I Uaskex- ¥-A- = Styles
Clipboard Basic Text Styles
AR
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Q1 Review

Friday, September 23, 2016

12:14 PM

Agenda

summary of Pravious Quarter
What's Coming This Quarter
Financials

Take-Away Items

Notes
Sales this quarter have been down compared to Q4 of last
Need to identify reasons and solutions

New social media strategies are in the works in the Market
A push is needed at years end to avoid the problem next .

What can we do?
Research potential destination "hot-spots”
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Commented [IG8]: Practice File: Notebook
1. Click in the Search field and type “C”
2. Click the Search list arrow.
3. Select This Notebook.
4. Select the Facebook option.
5. Select the Canada Tour option.
6. Click Find on page.

7. Click the Clear Search button.
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-
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Friday, September 23, 2016 12:14 PM

-
Planning Meeting

In less than three months North Shore Travel Will Introduc
package. There will be a meeting this Thursday at 9:30 A.M
finalize the Discover Canada marketing and pricing plans. \
schedule on this, so any additions or changes to the plans :

[ Facebook
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OneNote

Kayla Claypool
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Recent picks

@nada x v
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o Click a Search arrow. € Canada Tour - OneNote  Kayla Claypool
) Draw History Review
o Click the Clear Search button.

= % i | o B
Caliby -mno-

P StD B o by Styl : #8 Find Tags ﬁ MeIL]

T B e | Z-A =X =" P OutookTasks™ | pae e

H - - - Page  Details -
And the search is cleared. o - S - Emall | Mectings 9
{2 NST Notes = | Destinations . . Match 2 of [ canada X«

6 2 () Add Page
Canada Tour

Friday, September 23,2016 1214 PM Canada Tour
Mexico
Las Vegas
Planning Meeting

In less than three months North Shore Travel Will Introduce its new Discover
Canada Tour package. There will be a meeting this Thursday at 9:30 A.M. in the
auxiliary conference room to finalize the Discover Canada marketing and pricing
plans. We are nearly a week behind schedule on this, so any additions or changes
10 the plans should be submitted by Friday.
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]Print\

It's nice to have all your notes in electronic form in one location, but there will probably be times when you
also need to print them out. Let's see how!

0 Click the File tab.

e Click Print.

e Select a print option.

e Print: Send the document
straight to the printer.

o Print Preview: Check the
preview to make sure it
looks correct before
printing.

o Set the print preferences as
necessary.

o Click Print.

QI Review - OneNote  Kayla Claypool

Review  View

wl To Do Tag [
80, Find Tags =
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Paste.
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Footer:

T
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Brainstorm with team 1 new excursion in each of the top 5 destinations
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Commented [IG9]: Practice File: Notebook
1. Click the File tab.
2. Click Print.

3. Point out and describe the Print and Print Preview
options.

4. Click the Print range list arrow and select Current
Section.

5. Click the Footer list arrow and select the page
(number) option.

6. Click Print.




\Help\

If you come across a task in OneNote that you don't know how to complete, use the help feature!

o Click the File tab.
o Click the Help icon.

The OneNote Help window
opens.

e Select a topic or click in the
Search box.

o Type a topic and click the
Search icon.

o Select a related help topic.

You jump straight to the topic you
really need.
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Windows

Think of Quick Notes as the electronic equivalent of
a little yellow sticky note. Unlike paper though,
Quick Notes (formerly Side Notes) are instantly
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Q2 Review

A Create a Quick Note - OneNote 3 Review
ummary of Previous

v Work with a Quick Note. Press Windows-+N. This il

What's Coming
Financials command works whether or not OneNote is open

on your computer. Tip: If you have problems
creating a Quick Note, click ...

Take-Away Items

Notes
Sales this quarter have| | Manage unfiled notes in OneNote 2016 for
Need to identify reaso | Windows

New social media strat

When you take Quick Notes (formerly Side Notes)
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Commented [IG10]: Practice File: Notebook
1. Click the File tab.
2. Click the Help icon.
3. Click in the Search box.
4. Type “Typing Quick Notes” and click the Search icon.

5. Click the Manage unified notes option.






